
Sage HRMS 2016
Getting Started Guide

October 2015



Document version: 10/30/2015

This is a publication of SageSoftware, Inc.

Copyright © 2015SageSoftware, Inc. All rights reserved.

Sage, theSage logos, and theSage product and service names mentioned herein are registered
trademarks or trademarks of SageSoftware, Inc. or its affiliated entities. All other trademarks are the
property of their respective owners.

Windows ® and theWindows logo are either registered trademarks or trademarks ofMicrosoft
Corporation in theUnitedStates and/or in other countries.

The names of all other products and services are property of their respective owners.

Your use of this document and theSage product(s) described herein is governed by the terms and
conditions of theSageEndUser LicenseAgreement ("EULA") or other agreement that is provided
with or included in theSage product. Nothing in this document supplements, modifies or amends
those terms and conditions. Except as expressly stated in those terms and conditions, the
information in this document is provided by Sage "AS IS" andSagedisclaims all express, implied or
statutory warranties of any kind, including but not limited to thewarranties ofmerchantability, fitness
for a particular purpose or of non-infringement. No implied license is granted to you under any Sage
intellectual property or trade secret right. Sage reserves the right to revise, supplement or remove
information in this document at any timewithout notice to you or others.

SageEndUser License: http://na.sage.com/sage-na/eula

http://na.sage.com/sage-na/eula


Contents

Chapter 1: Introduction 6

Support and resources 6

Chapter 2: Starting Your System 7

Starting Sage HRMS 7

LogOn to Sage HRMS 7

LogOnUsing Sample Data 8

LogOnUsing Live Data 8

Use the Initialization File 9

Rebuild System Files 9

Uninstalling Sage HRMS 9

Chapter 3: Setup Checklists 11

Sage HRMS Setup Checklist 11

TimeOff Setup Checklist 12

Chapter 4: Navigating Sage HRMS 14

Accessing Tasks and Processes in Sage HRMS 14

Using the Navigation Pane 14

Using theMainMenu 14

Move Around in a Page 15

Shortcut Keys 19

Find an Employee 23

Using Advanced Find 25

Using the Organizer and Scheduler 27

Use the Task List 30

Use the Information List 32

Use the System Event List 34

To Schedule an Item 35

Schedule a Task or Information Item 35

Select the Task's Activity 35

Select the Task's Product 35

Getting Started Guide - iii



Select the Task 36

Select the Sub-Task 36

Select the Employer 36

Select a Subject 36

Enter a Description 36

Add a Note 37

Schedule the Date To BeDone 37

Automatic Advancement of Uncompleted Items 37

Select the User forWhom the Item is Scheduled 37

Set the Priority 38

Set the Frequency 38

Schedule a Task inMicrosoft Outlook 40

Schedule a System Event 41

Chapter 5: Setting Up Sage HRMS 43

Setting Up the Enterprise 43

Define Enterprise Options 44

Define Organization Titles 47

Select the Enterprise Logo 48

Set Up the Audit Trail 48

Define User-Defined Code Table Titles 50

Setting Up Employers 51

Set Up User Preferences 53

Default View 54

Employees Toolbar Default 54

Training Toolbar Default 54

HR Employer Default 55

U.S. Payroll Employer Default 55

Canadian Payroll Employer Default 55

Display Main Menu 55

Automatically schedule tasks in Microsoft Outlook 56

I want to opt out... 56

Setting UpCode Tables 56

To Copy Code Tables 58

Getting Started Guide - 4



To Add Codes 59

To Edit Codes 60

To Delete Codes 60

Add Codes From Details 61

Setting Up Security 61

Group Security 62

User Security 63

To Add aGroup 65

To Edit a Group 67

To Delete a Group 67

Set Field Level Security 72

To Set a Product Group Filter 73

Operators 74

To Edit or Delete a Product Group Filter 76

Allow All Users Access to All Fields 77

Restrict User Access to Fields 77

To Set Access Levels 78

Getting Started Guide - 5



Chapter 1: Introduction

This guide provides an overview for setting up and usingSageHRMS.

Support and resources

Sage strives to provide youwith the best help and support in the industry. If you have a
question, we're here to help!

n Help and documentation. Many answers to commonquestions can be found in
the help and documentation includedwithSageHRMSandon theSage
HRMS product documentationwebsite.

n Customer Support. For additional articles and resources, visit
https://support.na.sage.com or contact Customer Support at 800-829-0170. Please
have your SageCustomer Number handy when contactingCustomer Support.

n Sage City. Visit http://sagecity.na.sage.com for help, guidance, documents, and
downloads specific to SageHRMSandmodules.

n Tax forms. Because all printed forms have variations, SageHRMSPayroll only
supports forms printed by SageChecks andForms. Call SageChecks andForms
at 800-617-3224 or order online at www.SageChecks.com.
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Chapter 2: Starting Your System

Starting Sage HRMS

After you install the system, you are ready to start SageHRMSandbegin to learn about
and use the system’s features.

To Start Sage HRMS

1. From theStart menu, select All Programs > Sage > Sage HRMS Client > Sage
HRMS Client .

2. TheLogon page opens. You can log on in two different ways:

l To log on asMASTER, clear theWindows Logon check box and enter the logon for
theMASTER user.

l To log onwithWindows Authentication, select theWindows Logon check box and
enter yourWindows account user nameandpassword. Be sure to include the
domain in theUsername field (for example, FLSAGE\lizp, where FLSAGE is user
lizp's domain).

3. Select to use sample or live data. If you also installedSageHRMS Link, you can log
on toSageHRMS Link right from the logon page.

4. Click Logon to open the application.

Log On to Sage HRMS

When logging on toSageHRMS, you can select sample data or live data. The sample data
includes employees and scheduled tasks in theOrganizer, whichmimic how anactual
company may useSageHRMS. If you are new toSageHRMS, the sample data allows
you to familiarize yourself with entering data and using features without adversely affecting
your company’s production (or live) data.

Note: If you are aCanadian employer and youwant to use sample data, selectBoth from
theEnterprise Options tab of theEnterpriseSetup page and add aCanadian employer.

Logging On

Press Ctrl + U on the Logon page if youwant to update system files before logging on to
SageHRMS.
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LogOnUsing Sample Data

When logging on toSageHRMS, youmust log onwith yourWindows authentication or
enter a user nameandpassword to access either database.

LogOnUsing Sample Data

SageHRMSprovides a default user name for logging on to sample data.

1. SelectUse Windows Logon to log onwith yourWindows authentication.
Otherwise, enterMASTER in theUsername field.

2. Leave the Password field blank.

3. SelectSample Data.

4. Click Logon.

Live data is your company's production database, which contains employee information
and other company data. SageHRMSprovides a default user nameandpassword for you
to log on for the first time. After logging on, change the login credentials and set up security
according to your company's requirements.

LogOnUsing Live Data

1. SelectUse Windows Logon to log onwith yourWindows authentication.
Otherwise, enter your user name in theUsername field. If you are logging on for the
first time, enterMASTER.

2. Enter your password in thePassword field. If you are logging on for the first time,
leave the field blank.

3. Click Live Data.

4. Click Logon.

After logging on toSageHRMS, you can switch between live and sample data anytime.
This is useful if youwant to see how a feature or process works in the sample data before
implementing it in your live data. To switch between live and sample data, select the user
name menu > Log Off at the top of SageHRMS.
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Use the Initialization File

Use the Initialization File

SageHRMSprovides theSageHRMS initialization (ABRAWIN.INI) file to customize your
environment according to your needs. This feature provides additional capabilities for
usingSageHRMSonLocal AreaNetworks (LANs).

After installingSageHRMS, you can use theABRAWIN.INI file to specify any directory for
the following items: live data, sample data, temp file directory, and export directory.

Photos (.jpg, .gif, or .bmp files) displayed on theDemographics page are, by default, stored
in…\Sage\SageAbraSQLHRMSServer\Data\Photos. You can also use the
ABRAWIN.INI file to provide a different storage location by entering the appropriate path.

If you are using a LAN, you can keep theSageHRMSprograms (executable files) on your
local PC for fast access and then obtain information from a common server. By using the
ABRAWIN.INI file, you can assign the required paths to locate the information.

Rebuild System Files

When you first install SageHRMSor start SageHRMS, the system automatically
initializes your system and rebuilds your system files for you. This ensures you can
access the features that you are registered to use.

Theremight be times, such as with a power failure, when you need to rebuild your system
files to ensure you can access your installed options.

Note: Press Ctrl + U on the Logon page if youwant to rebuild system files before logging
on toSageHRMS .

To Rebuild System Files

1. Select Setup > System > Maintenance > Rebuild System Files.

2. Click Yes. The process begins and requires no other action on your part.When the
process is complete, you are returned to the log-in page.

Uninstalling Sage HRMS

Caution! If you set up the enterprise and added employers using live data, you should
back up all the files located in the \DATA subdirectory of your SageHRMS system. If
necessary, you can restore the files and access the data after re-installingSageHRMS.

To completely uninstall SageHRMS, youmust uninstall the clients and the server. If your
system includes Payroll, there are several payroll modules that will also be uninstalled.
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Uninstalling Sage HRMS

To Uninstall Sage HRMS

Touninstall SageHRMS, remove the following programs, in the order listed. Youmust
have administrator privileges to uninstall. You can only use the Add/Remove Programs
function to uninstall theSageHRMSapplication. You cannot use setup.exe to uninstall.

1. Go toAdd/Remove Programs.

2. RemoveSage HRMS Client. Note that when the client is uninstalled, all Payroll
modules are also removed.

3. RemoveSage HRMS Server.
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Chapter 3: Setup Checklists

Sage HRMS Setup Checklist

Before you begin usingSageHRMS youmust complete several steps. These setup steps
allow you to customize the system tomeet your employer's requirements precisely.

Steps to Set Up Sage HRMS

1. Set up the enterprise. Consider the enterprise as the parent company of your
organization. The enterprise contains the standards for your system. You can insert
a logo and specify organization titles as you set up the enterprise.

2. Set up the audit trail for the enterprise. TheAudit Trail gives you the ability to track
changes made to the system databases. You can select the database files and
fields to audit as well as choose to enable or disable the audit.

3. Addemployers. Before you can set up an employer, youmust add an employer to
the system. You enter its nameandaddress as youwant them to appear on reports.
You can also define theway your employer pays most of its employees, including
frequency and units.

4. Set up employers. For eachSageHRMSproduct you are using (SageHRMSand
TimeOff), youmust define unique parameters for each employer you add to your
system.

5. Set upCodeTables. Your system uses codes tomanage and store information in
files. These codes provide abbreviated and standard references to specific
information. This step enables you tomodify or add to those codes as you
customizeSageHRMS to theway you do business.

6. Set upBenefits. SageHRMSuses the guidelines you define for employee benefits.
This step allows you to easily manage even themost complex benefit plan, including
your employer's insurance and savings plans as well as any rate tables used by the
plans.

7. Set up security. The system provides an extensive, flexible and easy-to-use
security system to help you protect your data. During this final step in the setup
procedure, you establish security limits and privileges for all system users. The
security system breaks out functions by product, employer, activity, task, and step.
When you set up security, you assemble users in security groups and establish
passwords for each user.

After you complete the preceding steps, you are ready to begin usingSageHRMS.
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TimeOff Setup Checklist

Time Off Setup Checklist

TimeOff uses the records inSageHRMS to help you build your attendance tracking
system so you can administer attendance benefits and track employee absences.

After you set up your enterprise, employers, code tables, and security in SageHRMS, you
are ready to provide TimeOff with the basic information necessary to start tracking and
accruing employee absences and benefits.

Youmust complete several steps before you begin usingTimeOff.

Steps to Set Up Time Off

1. Set up the enterprise. Consider the enterprise as the parent company of your
organization. The enterprise contains the standards for your system. You can insert
a logo and specify organization titles as you set up the enterprise.

2. Set up the audit trail for the enterprise. TheAudit Trail gives you the ability to track
changes made to the system databases. You can select the database files and
fields to audit as well as choose to enable or disable the audit.

3. Addemployers. Before you can set up an employer, youmust add an employer to
the system. You enter its nameandaddress as youwant them to appear on reports.
You can also define theway your employer pays most of its employees, including
frequency and units.

After adding your employer, you can begin setting up the employer and your code
tables. Youmust first set up your employer and codes inSageHRMS.

4. Set up an employer for TimeOff. For eachSageHRMSproduct you are using (Sage
HRMSandTimeOff), youmust define unique parameters for each employer you
add to your system.

5. Set up code tables. Your system uses codes tomanage and store information in
files. These codes provide abbreviated and standard references to specific
information. This step enables you tomodify or add to those codes as you
customize the system to theway you do business.

6. Set up security. After setting up your employers and code tables, you are ready to
set up security. The system provides an extensive, flexible, and easy-to-use
security system to help you protect your data. During this final step in the setup
procedure, you establish security limits and privileges for all system users. The
security system breaks out functions by product, employer, activity, task, and step.
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TimeOff Setup Checklist

When you set up security, you assemble users in security groups and establish
passwords for each user.

7. Set up attendance plans. Attendance plans define types (vacation, sick leave, etc.),
calculationmethods, and other information required to track time off. Optionally, you
can configure TimeOff to use rules and data from SageHRMSPayroll to calculate
maximum available hours, maximum carryover hours, and total carryover hours.
This approach ensures that TimeOff calculations based on hours worked reflect
actual hours as recorded inSageHRMSPayroll.

After you complete the preceding steps, you are ready to enroll employees into attendance
plans. Use theAttendanceSummary page to enroll each employee in an attendance plan,
include year-to-date absence and attendance benefits information, enter the previous
year’s carryover units andmodify the information as needed. TimeOff provides the
procedures and utilities to assist you as you fulfill your employer’s attendance tracking
requirements.
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Chapter 4: Navigating Sage HRMS

Accessing Tasks and Processes in Sage HRMS

SageHRMSprovides different ways to access the tasks, processes, and features you
need tomanage your human resources.

The Navigation Pane

Use the navigation pane at the left of SageHRMS to navigate tasks and processes for
each function.

The Main Menu

Themainmenu is hidden by default. If you choose to display themainmenu, it appears at
the top of the page and provides menus for each action.

Using the Navigation Pane

Thenavigation pane is themenuon the left side of your SageHRMSdesktop. It provides
quick and easy access to tasks and processes in the program.

Note: Groups, tasks, and processes towhich you do not have security access do not
display on the navigation pane.

Hierarchy in the Navigation Pane

There is a hierarchy in the navigation pane, youwill need to select them in the following
order.

1. Group - For example, Employees, TimeOff, Training, Reports

2. Subgroup - You don't have to click on a subgroup to access the corresponding
tasks, but you can expand or collapse a list of tasks in a subgroup by pressing or
.

3. Menu item in the subgroup.

Using the Main Menu

This legacy menuat the top of SageHRMSprovides access to all items in theActions,
Processes, Analysis, Reports, Rules, Details, andQuery menus.When you select an
item from thesemenus, a list opens that contains all the products installed on your system.
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Move Around in a Page

Somemenus include aSystem selectionwhich includes activities relating to the entire
system rather than an individual feature.

To Display or Hide the Main Menu

When you start SageHRMS, themainmenu is hidden. To show or hide the legacy main
menu, each user must:

1. SelectSettings ( ) > User Preferences. TheUser Preferences window opens.

2. Select the check box Display Main Menu to show themainmenu, or clear the
check box to hide themainmenu.

3. ClickOK.

4. Click Yeswhenprompted to rebuild your system files.

Note: Tasks or processes for which you do not have security access do not appear on
menus or on the navigation pane.

Move Around in a Page

A page contains several fields intowhich you enter data or select data from a list.When
youwork inside a page, youmove from field to field to enter information.When you
highlight the field, you can enter information into it. The following table lists someways to
move around in a page.

Use
This

To Perform This Task

Tab Move forward from field to field (left to right and top to
bottom).

Shift +
Tab

Move from previous field to field (right to left and
bottom to top).

↓↑→← Move the selection cursor from field to field or within a
field.

Mouse Place the selection cursor in a field or within a text box.

Use Tabs

Many pages contain two or more tabs. Each tab contains different fields. For example, the
Demographics page contains three tabs:
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Move Around in a Page

l Address and Phone - Contains the employee’s address and phone number.

l Personal - Contains the employee’s personal information.

l Photo - Contains the employee’s photograph.

Tomove to another tab, click on the tab label. For example, click thePersonal tab label to
view thePersonal page. You can also press theRight Arrow→key on your keyboard to
move to the next tab or theLeft Arrow←key tomove to the previous tab.

Select From a Drop-Down List Box

To fill in a field, select from adrop-down list box. A drop-down list box lets you select one
item from a list of several items. The following figures show examples of a closed and open
drop-down list.

Closed

Open

The following table describes how to open and select items from adrop-down list box.
Make sure you highlight the field onwhich youwant towork before you perform the
following tasks:

Getting Started Guide - 16



Move Around in a Page

To Do This Do This

Open the list
using your
keyboard

Press the spacebar.

Open the list
using your mouse

Click the arrow.

Close the list
using your
keyboard

Press the spacebar.

Close the list
using your mouse

Select an item or click
outside the list.

Select an item
using your
keyboard

From either an open
or closed list, type the
first letter of the item,
or press ↑or ↓to find
the item.

Select an item
using your mouse

From anopen list,
click the item.

Enter Text in a Text Box

Entering information in a text box is another way to fill in a field. Each text box limits the
number of characters or digits you can enter. TheDataDictionary contains the limit for
each database field. The following figures show empty and filled text boxes.

Empty

Filled

Note: If you are using the add-on import/export application, SageHRMS Link, to export
your data toADPPC/Exchange, be aware that some fields can accommodatemore
characters thanADP canaccommodate. For a description of these fields, refer to your
SageHRMS Linkmanual.

The following table describes the different functions you can perform inside a text box.
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Move Around in a Page

To Do This Do This

Enter information
in a blank field

Type characters and
digits up to the field
maximum.

Replace
information in a
field

Click and drag the
mouse over the field
to highlight; then type
characters and digits
up to the field
maximum.

Delete all
characters in a
field

Click and drag the
mouse over the field
to highlight and click
Delete.

Delete one
character in a
field

Place the cursor to the
left of the character to
delete and click
Delete.

Insert one
character in a
field

Place the cursor to the
right of the insertion
point and type.

To Enter a Date in a Text Box

Entering a date in a text box is a bit different from entering text in a text box. A date always
contains themonth, day, and year. Therefore, the dashes between themonth and day are
permanently included in the text box. An example of a date text box appears below.

l To type a date into a text box, highlight the field. Then, type two digits for themonth,
two digits for the day, and four digits for the year. For example, we typed "01111953"
for the figure above.

l As analternative to typing the date, you can click the right mouse button. A calendar
control opens enabling you to select a date from the calendar display. The calendar
opens displaying the current date circled in red. Click a date to select it and close the
calendar. Selected dates are highlighted in gray.
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Shortcut Keys

l Clicking the arrows in the top left or top right of the calendar displays the previous or
nextmonth. Click on themonth to display a pop-upmenu that lists all months within
the year. Select amonth from the list.

l Click on the year to display arrows which enable you tomove the year up or down.
Return to the current day by clickingToday at the bottom of the calendar.

l ClickOK to close the calendar. The date you selected appears in the text box.

To change an existing date, right-click the field to open the calendar, or highlight the date
and do one of the following:

l Type the new date

l Click + or - to increase or decrease the date

Close and Resize pages

To close a page, click theClose button located in the top right-hand corner of the page
title bar. If you havemade changes, the system will ask whether youwant to save your
changes.Yes saves the changes and close the page;No closes the pagewithout saving
the changes.

To enlarge a page, click theMaximize button located in the top right-hand corner of the title
bar. If the page is already enlarged, you can reduce its size by clicking theRestore button.

Access Context-Sensitive Help

You can access Help for each page by clicking theHelp button on any window. This
provides information about thewindowwithwhich you areworking.

Shortcut Keys

SageHRMS is designed to be usedwith amouse pointing device. By using themouse, it is
easier to point to and select fields and buttons on the page. However, in some situations,
youmight find it easier to use your keyboard. SageHRMSadheres to theMicrosoft
Windows standard for mouse-equivalent keystrokes.

Accessing the Main Menu

Instead of using themouse, you can use the keyboard to access and select items from the
mainmenu. For instance, instead of clicking onAnalysis, you can hold downAlt and
press L. To access Processes, hold downAlt and press R. The underlined letter in each
menu category indicates the letter to press to select themenu category.
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Shortcut Keys

Note: Themainmenu is hiddenwhen you start SageHRMS. SeeUsing theMainMenu for
instructions to show themenu.

Press This To Select this Menu Item

Alt + F File

Alt + E Edit

Alt + I Actions

Alt + R Processes

Alt + L Analysis

Alt + R Reports

Alt + U Rules

Alt + D Details

Alt + Q Query

Alt + H Help

After you have selected amainmenu item, you can use the keyboard to do one of the
following:

l Press ↓ to navigate to the other options for the selectedmenu item.

l Press→ to highlight the nextmenu category.

l Press one of the underlined letters to display the corresponding drop-downmenu.

l Press Enter to open the selectedmenu item.

l Press Esc to cancel your task and return to the task onwhich youwereworking.

Note: Certain hot keys may changewhen you access certain pages inSageHRMS. If
there is more than one item with the samehot key, you can press the hot key again to
toggle between them. Press ↓ to access the options for the selectedmenu item.

Using the Tab Key

Use theTab key tomove from one field to another within a page or dialog box. For
example, as you complete theAddNewHire task, theAddNew Employee page enables
you to enter a first, middle, and last name for the new employee. After you enter the first
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Shortcut Keys

name, press Tab tomove to themiddle name field. You can also press and hold down
Shift and press Tab tomove up or backwards one field.

This feature is particularly useful when you areworking on a pagewhich contains many
fields. You can keep your hands on the keyboardwhile you navigate around the fields in the
page using theTab key.

Using the Edit and Search Keys

You can use the standardWindows edit features to cut, copy, paste selected text.

Press This To Open this Function

Ctrl + X Cut

Ctrl + C Copy

Ctrl + V Paste

Ctrl + F EmployeeFind

Keyboard Shortcuts

You can use the keyboard shortcuts to open pages andmove from onepage to another.

Note: The list of shortcut keys might be different for a customized system or if you do not
have access to every page.
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Shortcut Keys

Press
This

To Open this Page

F1 Context SensitiveHelp

Ctrl +
R

AbsenceTransactions

Ctrl +
E

AttendanceSummary

Ctrl +
J

Current Job

Ctrl +
P

Current Pay

Ctrl +
D

Demographics

Ctrl +
B

Dependents andBeneficiaries

Ctrl +
H

HRStatus

Ctrl +
I

InsuranceBenefits

Ctrl +
O

JobHistory

Ctrl +
L

Leave of Absence

Ctrl +
S

Savings Benefits

Ctrl +
T

Termination

Ctrl Custom Details
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Find an Employee

Press
This

To Open this Page

+ U Note: Press Ctrl + U on the Logon page if youwant to update system
files before logging on toSageHRMS.

Ctrl +
M

EmployeeActivity

Ctrl +
4

EmployeePayroll

Ctrl +
Y

TransactionHistory

Find an Employee

TheEmployeeFind enables you to search for an employee by status, last and first name,
ID andSocial Security Number.

Youwill need to find an employee before you can view details and perform tasks.

Fields on the Employee Find

The following fields are available on theEmployeeFind:
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Find an Employee

Search Field Definition

Last Name Enter a value to search by the last name.When searching by
Last NameandFirst Name, the Last Name field acts as a "go to"
feature navigating you to thematching nameon the list.

First Name Enter a value to search by the first name.When searching by
Last NameandFirst Name, theFirst Name field acts as filter,
narrowing down your search to the employees with that value you
enter in the field.

ID Enter a value to search by the employee ID.

SSN Enter a value to search by theSocial Security Number.

Active Select this option to include active employees.

Terminated Select this option to include terminated employees.

LOA Select this option to include employees on leave of absence.

Other Select this option to include other statuses likeCOBRA
dependents, or non-employees.

Find an Employee

1. Select Employees > View/Edit Employee. TheEmployeeFind pagewill display.

Tip: To open theEmployeeFind page, you can also use the shortcut key
combinationCTRL+F.

2. Select the statuses youwant towork with (Active, Terminated, LOA, orOther).
Disable the ones you don't want to include in the search. The number ofRecords
Foundwill be based on status.

3. Enter the search criteria in the fields. As you type the values in the field, the system
will highlight thematching record, or closestmatching record in the search results.

Note: If you enter a value and the system does not find amatch, "Not
Found" displays next to the search field.

4. After you have found the employee you are searching for, you can double click the
employee name, or clickOK. The employee detail pagewill display for the selected
employee.
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Using Advanced Find

Navigating through a list of Employees while on Detail Pages

Youhave the ability to navigate through the list of employees from your initial search by
using theFirst, Previous, Next, and Last buttons on theEmployee InformationBar.

Using Advanced Find

TheAdvancedFind is accessed by selectingMore Options on theEmployeeFind page.
With theAdvancedFind you can further narrow your search by entering additional criteria
about organization levels, supervisor, employee type, as well as other fields.

WhenusingAdvancedFind, the search results expand to display the additional criteria
fields.

Note: Collapsing theAdvancedFind saves the search criteria for the next time you open
theAdvancedFind. However, when it is collapsed, theAdvancedFind search criteria does
not affect the navigation.

Fields on the Advanced Find

The following fields are available.
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Using Advanced Find

Search Field Definition

Organization Levels
(1- 5)

Search by organization levels that you have specified in
EnterpriseSetup.
IfAll is selected, all records are considered in the search results.
IfNone Specified is selected, only employees without values in
the corresponding fields are considered in the search results.
Note: If anOrganization Level Title does not exist, the label will
display as None.

Supervisor Search by a list of primary supervisors.
IfAll is selected, all records are considered in the search results.
IfNone Specified is selected, only employees without a primary
supervisor are considered in the search results.
Note: If an employer is selected in theEmployer Filter, only
supervisors for the selected employer are available. If the
Enterprise is selected, all supervisors in the system are
available.

EmployeeType Search by the employee type.
IfAll is selected, all records are considered in the search results.

Salaried/Hourly Search by the employee's salary or hourly status.
IfAll is selected, all records are considered in the search results.

JobTitle Search by job title by the followingmethods:
ChooseContains and enter a specific search string. All
employees whose job title contains the search string are found.
ChooseExact and select a specific job title from the drop-down
list.

State Search by state.

Last HireDate Search by last hire date. Enter a "From" and "To"Date to search
by.
If From andTo dates are entered, the search results display all
employees with thematching criteria.
Note: Youhave the option to search only with aFrom or only
with aTo date.
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Using the Advanced Find

1. SelectEmployees > View/Edit Employee. TheEmployeeFind page displays.

2. SelectMore Options.

3. Enter criteria in the fields to narrow your search. Results will display in the list with
the closetmatching record.

Using the Organizer and Scheduler

About the Organizer and Scheduler

TheOrganizer shows you tasks and information items scheduled for you. TheOrganizer
includes theScheduler, which allows you to plan tasks for yourself or someoneelse.

SelectConnected Services > Sage HRMS Tools > Organizer to open theOrganizer.

Note: Select Organizer in theDefault View field inUser Preferences if youwant the
Organizer to open in theworkspace after you log on toSageHRMS.

Using the Organizer

TheOrganizer you seewhen you useSageHRMS is your ownpersonalOrganizer; all
scheduled tasks and information items are yours.

TheOrganizer first opens to the current date and provides three lists: tasks, information,
and system events. It displays all tasks, messages, and events scheduled for the current
date.

Using theOrganizer lists, you can schedule and carry out tasks. You can also record
information and plan system events. All uncompleted activities and information are rolled
over from day to day.

Move Around in the Organizer

Useany of the followingmethods tomove around the calendar:

l To jump to the current date, click theDate button on theOrganizer toolbar.

l Tomove to a different day in the currentmonth, click the day in the calendar.

l Tomove to a differentmonth, right-click themonth. A list drops down from which you
can select a newmonth.
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l You can alsomove to the previous month by clicking the first date in the calendar or
any date belonging to the previous month, or move to the nextmonth by clicking the
last date in the calendar or any date belonging to the nextmonth.

l Tomove to another year, right-click the year. A list drops down from which you can
select a different year.

You can also use the keyboard tomove to a different date, as described in the following
table.

To
Press
This

Move to the previous day. ←

Move to the next day. →

Move to the previous week. ↑

Move to the next week. ↓

Move to the beginning of the
month.

Home

Move to the end of themonth. End

Move to the previous month. Page
Up

Move to the nextmonth. Page
Down

Use the Organizer Toolbar

TheOrganizer toolbar, located just above theOrganizer, enables you to start tasks, jump
to today’s date, schedule items, delete or edit items in the lists, and update theOrganizer.

TheOrganizer toolbar contains six buttons.
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Button Description

Execute aTask

Use this button to complete a specific task in the
Task list. To start a task, click the task description
and click theStart button.
Tip: Instead of using theStart button, you can also
double-click the task to start it.
Depending onwhat the task is, the first scheduled
step in the task appears. For example, if you
scheduled theAddNewHire task as your task and
you start the task, theAddNew Employee dialog
box opens for you to enter the nameof the new
employee. This is the first step for recording a new
hire.
Note: Theonly type of item you can start is a task.
However, you can edit or delete all types of items,
including tasks, information items, and system
events.

Jump to Today
TheDate button enables you to quickly jump to the
current date.

Add Item toScheduler
TheScheduler lets you schedule a new task,
information item or system event. To access the
Scheduler, click theScheduler button.

Delete Item inScheduler

The Delete button deletes a task, information item
or system event. As a precaution, the system asks
you to confirm the deletion. To delete an item,
highlight it and click theDelete button.
Note: A system event can only be deleted by the
user for whom it is scheduled.

Edit Item inScheduler

TheEdit button enables you to change information
for a specific item. To edit an item, highlight it and
click theEdit button.
TheScheduler opens for you to edit the item's
information.
Note: A system event can only be edited by the
user for whom it is scheduled.

RefreshOrganizer The system frequently refreshes your Organizer and
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Button Description

brings it up to datewith items other users might have
scheduled for you. Additionally, you can click the
Update button any time youwant to refresh your
Organizer.

Use the Organizer Lists

Consider these your "to-do" lists. You use theScheduler to place items on these lists. At a
glance, you can browse through all tasks, information items and system events that were
placed on your Organizer for the selected day.

Items on the list are either completed or uncompleted. All uncompleted tasks and
information items scheduled for dates prior to the current day are rolled over when you log
on to the system.

There are three lists in the Organizer

Use the Task List

A task is anAction, Process, Report, Analysis, Rule, or Detail.When you schedule a
task, it appears on your Organizer or another user's Organizer if you scheduled it for
someoneelse.

TheTask list shows all tasks scheduled for you. At the time you complete the scheduled
task, theCompleted field is automatically selected, indicating the task has been
completed.

The following table describes how towork with theTask list.
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To Do This

Start a Task Click the task and click theExecute a
Task button.
-or-
Double-click the task.

Edit a Task Click the task and click the Edit Item in
Scheduler button.
-or-
Click the+ button next to the task.
TheScheduler appears. Change the
necessary information.

Delete aTask Click the task and click theDelete Item in
Scheduler button. Confirm the deletion.
-or-
Click the+ button next to the task. The
Scheduler appears. Click Delete. Confirm
the deletion.

Display the task's
Note page

Right-click the task.
TheNotes page opens. Edit the
information as necessary. ClickOK to
save your changes and return to the
Organizer.
Note: You can also edit Notes in the
Scheduler.

See tasks that
extend beyond the
list

Use the vertical and horizontal scroll bars.

Change status to
Completed

Select theCompleted check box.
-or-
Click the task and click theEdit button to
open theScheduler. Select theThis Item
is Complete check box.
-or-
The system detects when the item is
complete and automatically selects the
Completed check box.
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To Do This

Change status to
not completed

Clear theCompleted check box.
-or-
Click the task and click the Edit button to
open theScheduler. Clear theThis Item
is Complete check box.
Note: You can only clear aCompleted
check box for tasks completed on the
current day.When viewing past dates, you
cannot change the status to not
completed.

Use the Information List

Use the Information list to schedule any type of information. You can use this as a
personal to-do list to remind yourself of anything from scheduling ameeting tomaking
hotel reservations for your next business trip.

Like theTask list, theCompleted field indicates the completion status. However, an
information item is not anAction, Process, Analysis, Report, Rule, or Detail, so your
system cannot detect whether or not it is complete. Youmust change an information
item's status.

The following table describes how towork with the Information list.
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To Do This

Edit an Information
Item

Click the information item and click the
Edit Item in Scheduler button to open
theScheduler.
-or-
Click the+ button next to the item to open
theScheduler. Change the necessary
information.

Delete an
Information Item

Click the information item and click the
Delete Item in Scheduler button.
Confirm the deletion.
-or-
Click the+ button next to the item. The
Scheduler appears. Click Delete.
Confirm the deletion.

Display the item’s
Note page

Right-click the Information item. The
Notes page opens. Edit the information as
necessary. ClickOK to save your
changes and return to theOrganizer.
Note: You can also edit Notes in the
Scheduler.

See items that
extend beyond the
list

Use the vertical and horizontal scroll bars.

Change status to
Completed

Select theCompleted check box.
-or-
Click the information item and click the
Edit button to open theScheduler. Select
theThis Item is Complete check box.

Change status to
not completed

Clear theCompleted check box.
-or-
Click the information item and click the
Edit button to open theScheduler. Clear
theThis Item is Complete check box.
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Use the System Event List

If you need to schedule a task that pertains to the entire system, you can schedule a
system event. You can schedule any task to be a system event, that is, any Action,
Process, Analysis, Report, Rule, or Detail.

You can also schedule an information item as a system event if you like. For example,
you can remind everyone to back up their databases every Friday.

The following table describes how towork with theSystem Event list.

To Do This

Edit a system
event

Click the system event and click theEdit Item in Scheduler
button to open theScheduler.
-or-
Click the+ button next to the event to open theScheduler.
Change the necessary information.
Note: Only the user for whom the system event is scheduled
can edit it.

Delete a
system event

Click the system event field and click theDelete Item in
Scheduler button. Confirm the deletion.
-or-
Click the+ button next to the event. TheScheduler appears.
Click Delete. Confirm the deletion.
Note: Only the user for whom the system event is scheduled
can delete it.

Display the
system
event's Note
page

Right-click the system event. TheNotes page opens. Edit
the information as necessary. ClickOK to save your
changes and return to theOrganizer.

See items that
extend
beyond the list

Use the vertical and horizontal scroll bars.

Use the Scheduler

TheScheduler lets you schedule tasks, information or system events for yourself or
someoneelse.When you schedule these items, they appear in either the Task,
Information, or System Event list on theOrganizer.
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Note: Tasks can only be scheduled for users whohave access to the tasks. For example,
youmight want to schedule your coworker, Liz, to delete several employees from the
database. However, Liz does not have security access to theDeleteEmployeeRecord
task. Therefore, you cannot schedule this task for her.

TheOrganizer first displays the lists according to the item's priority you designatewhen
you schedule the item. Items with the highest priority appear at the top of the list while items
with the lowest priority appear at the bottom. TheOrganizer then sorts the items in the
order inwhich they were scheduled.

An item appears on your Organizer until it is completed or deleted.

Available Tasks

To Schedule an Item

With theOrganizer open, click theAdd Item to Scheduler button on the toolbar to open
theScheduler.

Schedule a Task or Information Item

Click the appropriate radio button, either Task or Information, for the type of item you are
scheduling.

When you select Information, theActivity andProduct fields are disabled because they
do not apply to information items.

Select the Task's Activity

This field specifies the activity containing the task. For example, if you schedule theMass
Update task, selectProcess. Or if you are scheduling theRehireEmployee task, select
Action. These two tasks, Mass Update andRehireEmployee, are a process and an
action, respectively.

Select the Task's Product

All SageHRMSproducts appear in this list, as well as System. System includes activities
pertaining to your entire system rather than an individual product.

Getting Started Guide - 35



Select the Task

Select the Task

This field contains the task you are scheduling. The list contains all the tasks included in
the selected task's activity and product. The list changes when the task's activity and
product change.

If you are scheduling an information item, theTask field is disabled.

Select the Sub-Task

Some tasks have associated sub-tasks. A sub-task is simply another level of task within
the task you select. If sub-tasks do not apply to your selected task, the field is disabled.

Select the Employer

Formost tasks, you are required to select an employer. For example, if you areworking
with SageHRMSand select theRecordPerformanceReview task, youmust select
which employer contains the employee for whom youwant to record a performance
review.

TheEmployer field is disabled if there is only one employer set up in your enterprise or if
the task is an Information item.

Select a Subject

Tasks require specific information before they are processed. For example, theRehire
Employee task requires an employee's name. The items in the list change according to
the task you select. If you forget to select a subject, the system warns youwhen you click
OK to close theScheduler.

If you are scheduling an information item, theSubject field is disabled.

Enter a Description

This is a short description of the task, information item or system event. The description
appears on theOrganizer of the user for whom the item is scheduled. If you are
scheduling a task, the system fills in the description automatically by combining the task
(or sub-task, if one is selected) and the subject.
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You can change theDescription field as necessary, but you cannot leave it blank. If you
accidentally leave theDescription field blank, the system fills it in for you.

Add a Note

TheNotes text area of theScheduler enables you to fully describe the item. You can enter
an unlimited number of characters. Use the scroll bars as necessary.

When youwork with theOrganizer andwant to see the note associatedwith a task,
information item or system event, right-click the item to read and edit the note.

Schedule the Date To BeDone

This is the date onwhich the item is scheduled for completion. The item appears on the
Organizer on this date. SageHRMSautomatically schedules the item for the day
currently selected in the calendar, but you change the date.

Enter theTo Be Done date inmm/dd/yyyy format. For example, enter March 27, 2015 as
03272015 (dashes are preformatted).

TheScheduled date is the date onwhich the item is being scheduled. It defaults to the
current date and cannot be changed.

Automatic Advancement of Uncompleted Items

If tasks or information items are not completed on the scheduled dates, the system
automatically rolls them over to the next time the user logs into the system. For example,
a task on Lynn’s Organizer should be completed on the 18th, but Lynn cannot complete
the task on the 18th. She doesn’t use her system again until the 23rd. The task rolls over
to the 23rd and stays on her Organizer until she either completes or deletes the task.

Note: Unlike tasks and information items, system events are notmoved forward.

Select the User for Whom the Item is Scheduled

TheScheduledFor list contains users whoare assigned user IDs and passwords when
security was set up for your system. If you are scheduling a task, only the users who
have security rights to perform that task appear in the list. For more information, see
SettingUpSecurity.
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Note: Thenameof the user who is scheduling the item is shown in theScheduled By
field and cannot be changed. This is the user who logged onto the system.

Set the Priority

You can choose from five levels of item priority: very high, high,medium, low, and very
low. This indicates the importance of the item you are scheduling. The selected priority
determines the order in theOrganizer’s tasks and information lists.

Set the Frequency

TheFrequency indicates howmany times the item should occur. The list includesOnce,
Daily,Weekly,Bi-Weekly,Monthly,Bi-Monthly,Quarterly, andYearly. If youwant the
task to repeat, select any frequency other thanOnce.

For example, youmight want to archive terminated employees once amonth. In this
case, selectMonthly as the frequency.

When you select a frequency, theRepeating Task dialog box automatically opens for you
to describe the task's repeat frequency.

The text entered in theScheduler's Description text area appears in theTask
Information field. TheScheduled Date andRepeat Frequency carry over from the
Scheduler. These three fields cannot be changed.

Repeat Items

TheRepeat This Item field lets you specify the number of times to repeat this item.
Except for aRepeat Frequency ofDaily, you can repeat an item as many times as
required up to a five year limit. For a daily repeat frequency, you can repeat an item up to
365 times.

TheRepeat Frequency is the number of times an item will appear on theOrganizer in
addition to the first date you schedule. For example, if you schedule an item to be done on
Tuesday, 4/12, and the repeat frequency is weekly and the number of times youwant to
repeat the item is three, then your Organizer shows the item on4/12 (the first
occurrence), 4/19, 4/26, and 5/3.

Use the arrows to select the repeat number or type a number in the text box. However, if
you type a number exceeding theRepeat Frequency limit, the number automatically
changes to the allowable limit. For example, if you type 6 for the number of years an item
is to occur, the number automatically changes to 5, the allowable limit.
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Tip: Each time you schedule an item to be repeated, the repeat occurrence of the item is a
separately scheduled item. If you edit a repeat item, theFrequency field on theScheduler
is disabled. If you find you need to change the repeat frequency of an item that is already
scheduled to repeat, do not edit the item. Rather, schedule a new item and its related
repeat frequency. Then, delete the old item.

Maintain the Day of the Week

You can choose tomaintain the day of theweek the item repeats. For example, if you
always want to repeat the item onaThursday,select the check box and select Thursday
from the drop-down list.

If maintaining the day of theweek does notmatter, clear the check box. The item then
repeats on the samenumerical date of themonth. For example, if you schedule an item
onApril 15 and youwant it repeated every month, the next occurrences will beMay
15,June 15,July 15, and so on, regardless of the day of theweek.

If the box is selected, theMove to Closest Date, Forward to Next Available Date, and
Backward to Last Available Date options becomeenabled.

Note: TheMaintain Day of Week check box and drop-down list are disabledwhen your
Repeat Frequency is daily, weekly, or biweekly, because they do not apply. In turn, the
related radio buttons are disabled.

Move to Closest Date

This selection instructs theScheduler to repeat the task on the date falling closest to the
next date to repeat the task while at the same timemaintaining the day of theweek. This
selection lets theScheduler choose the next date to repeat the task. It either chooses a
date previous to or following the scheduled repeat date.Move to Closest Date is the
default value.

For example, suppose youwant to repeat an itemmonthly and always want it to be done
onWednesday. Schedule the first task forWednesday, 11/17. InDecember, the 17th falls
on aFriday. TheMove to Closest Date selection tells theScheduler tomove this task to
Wednesday, 12/15 because it is only two days from the 17th, whereas the 22nd, also a
Wednesday, is five days from the 17th.

Forward to Next Available Date

This selection instructs theScheduler to repeat the task onwhatever the date is that
matches the specified day of theweek and follows the date onwhich the task is to be
repeated. UnlikeMove to Closest Date orBackward to Last Available Date, the
Scheduler mustmove forward to select the repeat task date.
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Using the sameexample as above, youwant to repeat an itemmonthly and always want
it to be done onWednesday. You scheduled the first task to be doneWednesday, 11/17.
InDecember, the 17th falls on aFriday. TheForward to Next Available Date selection
tells theScheduler tomove this task toWednesday, 12/22, because it mustmove forward
to the 22nd, not backward to the 15th.

Backward to Last Available Date

This selection instructs theScheduler to repeat the task onwhatever the date is that
matches the specified day of theweek and precedes the date to repeat the task. Unlike
Move to Closest Date andForward to Next Available Date, theScheduler mustmove
backward to select the repeat task date.

Using the sameexample as above, youwant to repeat an itemmonthly and always want
it to be done onWednesday. You scheduled the first task to be doneWednesday, 11/17.
InDecember, the 17th falls on aFriday. TheBackward to Last Available Date selection
tells theScheduler tomove this task toWednesday, 12/15, because it mustmove
backward to the 15th, not forward to the 22nd.

When you complete setting values for theRepeating Task dialog box, clickOK to save
the changes and return to theScheduler.

Schedule a Task inMicrosoft Outlook

When you schedule a task in theScheduler, you can also schedule it inOutlook. User
Preferences enables you to set the check box as always selected.

When theSchedule Task inMicrosoft Outlook check box is enabled, an email of the task
is sent to the person for whom it is scheduled.When they accept the task, it is scheduled
in their Outlook Task Manager.

If the person declines the task inOutlook, an email is sent to the personwho scheduled
the task; however, the task is not updated in theScheduler.

After the task is completed inSageHRMS, it is automatically marked as completed in
Outlook.

Note: Refer to theMicrosoft Outlook online help for further information regarding the
features of Outlook.
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Schedule a System Event

You can schedule a system-wide item, aSystem Event, pertaining to all users on the
system. To schedule aSystem Event, selectSystem Event from thePriority drop-down
list.

Scheduling aSystem Event is a bit different from scheduling aTask or Information item.
When you schedule aSystem Event, it is automatically placed on your Organizer in the
System Event list and it is placed on every SageHRMSuser's Organizer as well. This
allows you to convey amessage to all other users on the system.

Here are two examples of a system event:

Suppose youwant to perform theMass Update process inSageHRMSonDecember 5
at 5:00 p.m. You need all other users on the system to exit SageHRMSbefore 5:00 so
you can run the process.

1. In SageHRMS, schedule theMass Update process for yourself (the default) with
thePriority as System Event. Schedule the process to be done 12/5/14. Add a
message in theNote text area: "Mass Updatewill occur at 5:00 today, December 5.
Please exit SageHRMSby 4:55 p.m."

2. TheMass Update process appears on everyone's Organizer in theSystem Event
section onDecember 5. Each user can view the note by clicking the+ button next
to the item to open the scheduler, or by right-clicking the item. That way, all users
know to exit SageHRMSbefore 5:00 p.m. However, theMass Update process
only appears in theTask section of the person scheduled to complete it.

Let's say you routinely perform E-mail maintenance every Friday at 5:30 p.m. andwant all
users to exit E-mail before you beginmaintenancework.

1. Since this is not a system task, schedule this as an Information item. Specify the
Frequency asWeekly and thePriority as System Event. Add amessage in the
Note text area: "Please exit E-mail by 5:30 today for weekly maintenance."

2. The Information item is placed on everyone's Organizer eachFriday. Users can
view the note by clicking the+ button next to the item to open the scheduler, or by
right-clicking the item.

Note: Only the user for whom the system event is scheduled can edit, delete, or
reschedule the system event.
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Mark an Item as Complete

TheTask has been completed check box in the lower left corner of theScheduler
indicates if the item is complete.When you edit a Task or an Information item, the
Scheduler opens with this check box enabled.

To signify the item is complete, select the check box. If you are editing a task you have
completed, the system automatically marks the item as complete.When you clickOK to
return to theOrganizer, the item's Completed check box is selected.

TheTask has been completed check box is disabledwhen you:

l Schedule a new task or information item.

l Schedule a system event, as there is no completed status for a system event.

l Edit an item completed prior to the current day.

Getting Started Guide - 42
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Setting Up the Enterprise

About the Enterprise Setup

Before adding employers and setting up their different requirements, youmust set up the
enterprise. TheSageHRMSenterprise feature lets you handle a group of employers as
one. The enterprise is an efficient time-saver used tomanagemultiple employers. The
enterprise has no employees, but it does provide access to code tables that set the
standards for your system.

Understanding the Enterprise

Theenterprise lets you group employers together and handle them as one. An enterprise is
not actually an employer, even though it appears in a list of employers on your system. The
enterprise has no employees, but it does help you establish standards for all the employers
in your system.

Think of the enterprise as the "corporate level," encompassing all employers under a single
umbrella. You have only one enterprise in your system, but you can have numerous
employers.

Each employer can have different setup specifications, such as different codes for the jobs
in the company or different salary grade structures.When you set up your employers, you
can specify different sets of specifications for each employer.

The enterprise feature helps you in two ways

l You save timebecause it allows you tomanipulate several employers' data at one
time rather thanworkingwith individual employers to complete identical tasks one at
a time.

l The information from all your employers is available to youwhen you are viewing
data or printing reports.

Enterprise as a Time-Saver

Theenterprise feature saves you timewhen you are setting up andmanagingmultiple
employers. For example, you have an umbrella corporation calledNational Systems, Inc.,
with three subsidiary employers calledACorp., B Corp., andCCorp. The umbrella
company, National Systems, and its three subsidiaries all have the samebenefit plans.
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If you are usingSageHRMS, all the codes in the enterprise benefit plan code table apply to
all employers in your system, unless you set up a different plan for a particular employer.
Therefore, when you first set up your three corporations, A Corp., B Corp., andCCorp.,
they automatically use the enterprise benefit plan code tables. You do not have to set up
separate benefit plans for each employer because they all conform to the enterprise
standards.

If you need to set up a unique plan for one of your employers, the enterprise still saves you
time. Copy an enterprise benefit plan to the employer, make your changes and save the
benefit tablewith an employer code. Now you have a unique benefit plan for this employer
and you did not have to create it from scratch.

The enterprise also efficiently handles changes to your setup. For example, if you have a
rate change in a dental plan and three employers use the enterprise dental plan, simply
change the rate once in the enterprise dental plan rather than three times. The rate change
youmake at the enterprise level affects every employer in your system except thosewho
have unique dental plans.

Enterprise as the Panoramic View

Use the enterprise feature to see a panoramic view of information inSageHRMS. For
example, when you print a report, select the enterprise andSageSageHRMSprints
information from all your employers in one report.Whenusing the filter feature to control
the information youwant to use, select the enterprise to give yourself access to data for all
employers in the system.

Setting Up the Enterprise

Log on toSageHRMS. Select Setup > System > Setup > Enterprise Setup.

After you define the enterprise setup information, clickOK to accept your changes and
close theEnterpriseSetup page. You can also click Apply to save your changes but
remain on the page. For example, youmay want to enter information on theEnterprise
Options tab, click Apply to save your changes, thenmove to theOrganization Titles
tab.

Defining Enterprise Options

Define Enterprise Options

TheEnterprise Options tab of theEnterpriseSetup page contains general setup
information for your system.
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Country.Select the country that represents the employers in your enterprise. The
country you select determines what information is displayed in your SageHRMS system.
For example, if an entireDetail page or a particular field on aDetail page does not apply for
a country, it either does not display or it is disabled for an employer in that country.

l SelectU.S. if all employers in the enterprise areUnitedStates employers.

l SelectCanada if all employers in the enterprise areCanadian employers.

l SelectBoth if there are bothUnitedStates andCanadian employers in the
enterprise.

The first time you log on toSageHRMS, the system asks you for a country setting for
your employers. If you need to change the country setting after the initial setting, you can
do so on theEnterpriseSetup page.When you change the country setting, youmust exit
SageHRMSand log on again to complete the country setting change.

Note: After initial setup of your enterprise, if you re-register with a new installation code to
either addU.S. payroll to aCanadian payroll system or addCanadian payroll to aU.S.
payroll system, youmust change theCountry setting toBoth after re-registering and
restartingSageHRMS.

Field List

Field Description

Enterprise
Name

Enter the nameof the enterprise. This name is shownon reports and
forms

Address and
City

Enter up to two street addresses and the city.

State/Province
andZip/Postal
Code

If the country setting is set toU.S., select the state and enter the zip. If
the country setting is set toCanada, select eitherState orProvince,
select the appropriate state or province from the next drop-down list,
and then enter theZip code or postal code.
TheState/Province is a required field.

Phone Enter the telephone number

Training
Employer

If you are using Sage HRMS Train, you can select a Training
Employer. If you are not using Sage HRMS Train, this field is
disabled
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Field Description

FedTax
ID/Business
Number

Enter either a Federal Tax Identification number (for aU.S. company)
or aBusiness Number (for aCanadian company)

Phone
Number
Format

Select the format inwhich youwant the employee telephone
numbers to display.

SSNMasking
Format

Choose the format that theSSNwill appear on your pages. You can
select to display the entire number (123-45-6789), mask (hide) the
entire number (XXX-XX-XXXX), or mask all, but the last four digits of
theSSN (XXX-XX-6789)

Report Footer
When you generate reports, the date appears at the bottom of each
page. You can choose to display both the date and time, or only the
date.

Show
SSN/SIN on
Detail Headers

Choose to show or hide the employee's social security number (for
U.S.) or social insurance number (for Canada) in the top section of
each employeeDetail page.

ShowUnion
Data

Choose to show or hide an employee's union affiliation.

Benefit History
Choose to enable or disable historical benefit information for
employees.

Automatically
Recalculate
Benefits

Choose to automatically calculate benefits:

l Daily – to update benefits only when the user logs intoSage
HRMS. If you select this option, SageHRMSwill not update
benefits when the user changes Employee pages.

l By Employee – to update benefits only when the user makes
changes onEmployee pages that trigger SageHRMS to update
benefits. If you select this option, SageHRMSwill not update
benefits when the user logs intoSageHRMS.

l Daily and By Employee – to update benefits when the user
logs intoSageHRMSandwhen the user makes changes on
Employee pages that trigger SageHRMS to update benefits.
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Field Description

l Never – tomanually update benefits.

Tip:When setting up your system, selectDaily orNever to prevent
the system from updating after every change.

Show
Inactive
Codes

As you set up employer or enterprise job codes, organization
codes, and reason codes, you set them as active or inactive.When
you setShow Inactive Codes toNo, codes set as inactive are not
included in the list of codes available for selection and assignment to
an employee.When you setShow Inactive Codes toYes, codes set
as inactive are included in the list of codes available for selection and
assignment to an employee.

Populate
Payroll
History

This field is available only if SageHRMSPayroll has been installed.
SelectYes to automatically updateSageEmployeeSelf Service
Payroll History during theCheck Print process inSageHRMS
Payroll. If your organization does not useSageESS, selectNo.

Defining Organization Titles

Define Organization Titles

TheOrganization Titles tab of theEnterpriseSetup page enables you to define up to five
organization levels for your enterprise. Use these levels as away to organize your
employees.

For example, RichardMiller accepts amarketing positionwithMultimedia
Communications. You add the new employee (RichardMiller) to one of your employers,
MultimediaCommunications. You specify the department as Marketing and the division
as Central. For this example, you define twoOrganization Titles: Department and
Division.

l After defining the organization titles, set up the codes for each organization title in
your Organization code tables. In the above example, Marketing is a code under
theDepartment organization title andCentral is a code under theDivision
organization title.

l Enter titles for up to five organization levels.
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l When you set up your Organization code tables, you can choose from this list of
titles for your enterprise's organization levels and then set up the codes for each
organization level.

Select the Enterprise Logo

The reports you generatewithin SageHRMS can include the nameandaddress of your
employer as well as a logo for your enterprise. TheLogo Setup tab of theEnterprise
Setup page enables you to select your logo.

Before selecting a logo, youmust be able to access it as a bitmap file, a filewith the .BMP
extension. A bitmap is a collection of picture elements arranged in a pattern resembling a
picture.

Note: You can create a bitmap file from scratch using any graphic editing package, such
as Microsoft Paint. You can also scan your logo and save it as a bitmap file.

If you areworkingwith live data (rather than sample data), theLogo Setup tab is blank
the first time it is opened.

If you areworkingwith sample data, theLogo Setup tab contains theDunedin
Enterprises logo the first time it is opened.

To Select a Logo

To select a logo, click Select. A dialog box opens so you can select the appropriate logo.

Select the correct path and nameof your logo's bitmap file. Only those files with a .BMP
extension appear. Click Select. The bitmapappears on theLogo Setup tab.

To Remove a Logo

To remove a logo from your system, click Remove on theLogo Setup tab.

When you remove a logo, you do not remove the bitmap file from your disk, only from the
SageHRMSdatabase. You can select the file again any time youwant.

Setting Up the Audit Trail

Set Up the Audit Trail

TheAudit Trail Setup tab of theEnterpriseSetup page enables you to set up the audit
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trail.

The audit trail provides the ability to track changes a user makes with a task or to a page.
This is an extremely useful tool for safeguardingSageHRMSdata. Auditing changes
enables you to:

l Check who is making changes to the system and if the correct changes are being
made

l Measure users’ performance

l Determine the number of changes users make and how often corrections are being
made

Theaudit trail provides a before and after image of changes. It also keeps track of the date
and timeand the user whomade the change.

The following standard reports are available tomonitor the audit trail. To access the audit
trail reports, selectReports > Audit Trail Reports from theNavigationPane.

l TheAudit Trail Report by User provides a list of audit trail records sorted by the
users who implemented the changes.

l TheAudit Trail Report by Date provides a list of audit trail records sorted by the date
onwhich the changes weremade.

l TheAudit Trail Report by File/Field provides a list of audit trail records sorted by the
files and fields inwhich the changes weremade.

To Set Up the Audit Trail

1. Click theAudit Trail Setup tab on theEnterpriseSetup page.

2. In theEnable Auditing field, selectYes to turn theAudit Trail on and to enable the
rest of the fields on the tab.

Note: Turning theAudit Trail on or off does not affect the audit status of your
selected files and fields. You can choose to audit any files and fields by setting their
Audit Status toYes orNo. If you turn theAudit Trail on, the selected files and
fields will be audited. If you turn theAudit Trail off, the files and fields will not be
audited, but their audit status is maintained.

3. In theSelect File to Audit field, scroll through the list of databases and click a
database containing the fields youwant to audit. As you select databases, the list
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of fields in the lower portion of the page changes to display the fields in the selected
database.

4. If youwant the system to audit the selected database file, select theEnable File
Audit check box. Otherwise, clear the check box. The database file is preceded
by aYes (the filewill be audited) or No (the filewill not be audited), depending on
whether you chose to audit the file.

5. The system provides threeways inwhich you can enable or disable auditing for
the fields in the selected database file.

a. Toenable auditing for all the fields in the selected database file, selectYes from
theAudit All Fields in File drop-down list. A check appears in theAudit column
next to each field in the file to indicate the audit status is Yes.

b. Todisable auditing for all the fields in the selected database file, selectNo from
theAudit All Fields in File drop-down list. The check is removed from the
Audit columnnext to each field in the file to indicate the audit status is No.

c. Toenable or disable auditing for individual fields in the selected database file,
select or clear the check box in theAudit columnnext to the field for which you
want to change the audit status.

Note: You can set audit status toYes for any editable field in a database.
However, the system only audits the field if you have enabled auditing on the
database file that contains the field. For example, you set your audit status toYes
for thePerformance Review Rating field in theEmployeePersonnel database
file. However, you did not enable file audit for theEmployeePersonnel database
file. In this case, the system will not audit thePerformance Review Rating field
(or any field in theEmployeePersonnel file).

6. When you have finished your audit trail setup, clickOK to save your changes and
close the page, or click Apply to save your changes and remain on the page. The
system proceeds tomodify the audited fields list.

Defining Code Table Titles

Define User-Defined Code Table Titles

TheUser Defined Code Table Titles tab enables you to define titles for your user-
defined code tables.
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Setting Up Employers

Adding an Employer

After setting up your enterprise, you are ready to start workingwith your employers.
Setting up your employers is much easier if you gather all the required information
beforehand.

You can have as many employers as you like. Each of these employers can have different
specifications, such as different codes for jobs in the company, or different salary grade
structures.When you set up your employers, you define different sets of specifications for
each employer.

Whenadding an employer to your system, youmust define somebasic information, such
as your employer’s nameandaddress. The employer's name is at the top ofmost pages
and prints onmost standard reports.

You can also define setup information for eachSageHRMS product you are using. The
system provides theAdd Employer task so you can add an employer at any time.

If your system includes Sage HRMS Payroll

If your system is SageHRMSPayroll (either U.S. or Canadian), youmust first set up a
SQLDatabase before you add an employer with these steps. Review the help in Sage
HRMS specific to SageHRMS Link for setting up a new database, and then return here to
add the payroll employer in SageHRMS.

To Add an Employer

1. SelectSetup > System > Setup > Add Employer to open theSteps for Add
Employer Task page.

2. Check the steps youwant to complete. Depending on the products you installed,
youmust set up the employer for each product you are using. Complete each step
now or schedule steps for yourself or another user to do later. Add Employer is a
required step.

3. ClickOK to start moving through the steps. TheEmployer Setup page opens.

4. If your installation is configured to support companies inmultiple countries, the
Employers Country field is enabled. Select the country inwhich this employer
does business: eitherCanada or U.S.
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5. Enter theEmployer Code that uniquely identifies the employer. Youmust enter
three characters.

6. Enter the Employer Name. This field is required because the nameappears at the
top of pages and prints onmost reports. You can also add the employer’s street
address, city, state or province, zip or postal code, telephone number and fax
number. TheCity andState/Province fields are required.

7. Select thePay Frequency used for themajority of the employees.

8. In theNormal Units field, enter the hours or units per pay periodworked by most
employees. For example, if employees are paid eachweek for a 40-hour week,
enter 40.00. If employees are paid every twoweeks for a 37.5-hour week, enter
75.00.

9. Select the employer's main spoken language. Select the Industrial Sector (used
for CanadianEmployment Equity reporting).

Note: The selections youmake for steps 7-9 are the defaults when you add new
employees to this employer.Whenadding employees, you can change these as
necessary.

10. If you have payroll installed, thePayroll Database ID andPayroll DB Name fields
appear. ThePayroll Database ID is dynamically populatedwith theEmployer
Code you entered inStep 5 and is disabled. InPayroll DB Name, enter the nameof
theSQLpayroll database.When you clickOK in the next step, SageHRMSwill
verify that the database is present and automatically create a company profile in the
database. A series of "ActivatingApplication"messages display indicating the
progress of the activation.

11. When you finish, clickOK.

12. Amessage displays that theAddEmployer process was successful. ClickOK to
restart the system. After restart, you are returned to theHomepage.

Modify an Employer

To Modify an Employer

1. Select Setup > System > Setup > Modify Employer. If you havemore than one
employer defined, youmust select the employer youwant tomodify.

2. Review and edit the information as necessary. You cannot change the employer's
Country orCode.
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3. If you are usingSageHRMSPayroll, youmust enter the ID for the payroll database
you created inSQLEnterpriseManager, in thePayroll Database ID field.

4. ClickOK to save your changes.

5. Amessage displays that theModify Employer process was successful. ClickOK to
restart the system. After restart, SageHRMSopens to theHomepage.

Delete an Employer

You can delete any employer added to your SageHRMS system, for example, an
employer you added by mistake.

The system provides two options to delete an employer:

l Delete the employer and employee information butmaintain the security information
and employer setup information.

l Delete all employer and employee information (including security options and
employer setup information).

Caution! Deleting an employer permanently deletes all the related employee information.
Before deleting an employer, back up the employer’s databases. If you need to restore
information, you can restore the databases from the backup.

If you useSageHRMSPayroll, employee information can only be deleted from Sage
HRMSdatabases and not the payroll databases using this procedure.

Delete an Employer

1. Select Setup > System > Setup > Delete Employer.

2. Select the employer youwant to delete and select the appropriate option for deleting
the employer information.

3. ClickOK to delete the employer. The system asks you to confirm the deletion.

4. Click Yes to delete the employer.

5. Amessage states theDeleteEmployer process was successful. ClickOK to
restart the system. After restart, you are returned to theHomepage.

Set Up User Preferences

SageHRMSallows you to customize specific features to suit your needs. The system
tracks these preferences for each user logging on toSageHRMS.
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l For example, you can select which navigation pane group opens when you log on to
SageHRMS.

From the top of SageHRMS, selectSettings ( ) > User Preferences to open theUser
Preferences page. This page includes two tabs:General Preferences andSetup
Interviews.

General Preferences Tab

Use the fields on theGeneral Preferences tab to select your user preferences.

Default View

Select the navigation pane group or feature that youwant to open in theworkspacewhen
you log on toSageHRMS.

Note: By default, theWelcome toSageHRMSpageopens in theworkspace after you log
on toSageHRMS. If youwant to hide theWelcome toSageHRMSpageand display only
the item you select in this field after you log on, selectDo not show me this page again
on theWelcome toSageHRMSpage.

Employees Toolbar Default

Select the employee-related page youwant to automatically openwhen you log on to
SageHRMS.

Note: TheEmployees Toolbar Default list includes only the pages towhich you have
security access. If you select a default page that the system administrator might later
restrict you from accessing, SageHRMSassigns the next available page in the list as the
default. If the restricted pagewas last in the list, SageHRMSassigns the first page in the
list as the default.

Training Toolbar Default

Select the training-related page youwant to automatically openwhen you log on toSage
HRMS. This field does not display if you do not haveSageHRMSTrain installed.

Note: TheTraining Toolbar Default list includes only the pages towhich you have
security access. If you select a default page that the system administrator might later
restrict you from accessing, SageHRMSassigns the next available page in the list as the

Getting Started Guide - 54



HR Employer Default

default. If the restricted pagewas last in the list, SageHRMSassigns the first page in the
list as the default.

HREmployer Default

This drop-down list shows all employers that have been set up in your HR program. The
employer you select here is the one that will be usedwhen you openSageHRMSand
view pages in the program, regardless of whether theEmployer Filter is set to Enterprise.
For example, if you areworkingwith reports or setup processes and your default
employer is DunedinEnterprises, the data used in the processes will be for employer
Dunedin Enterprises.

U.S. Payroll Employer Default

This drop-down list shows all U.S. Payroll employers that have been set up in your
system (with the assignedPayroll Database ID). The employer you select here is the one
that will be usedwhennon-employee level payroll pages are opened, regardless of
whether theEmployer Filter is set to Enterprise. For example, if you areworkingwith
payroll processes and your default U.S. Payroll Employer is US/ABC, the data used in the
payroll processes will be for employer US/ABC.

Canadian Payroll Employer Default

This drop-down list shows all CanadianPayroll employers that have been set up in your
system (with the assignedPayroll Database ID). The employer you select here is the one
that will be usedwhennon-employee level payroll pages are opened, regardless of
whether theEmployer Filter is set to Enterprise. For example, if you areworkingwith
payroll processes and your default U.S. Payroll Employer is Can/ABC, the data used in
the payroll processes will be for employer Can/ABC.

DisplayMain Menu

When selected, SageHRMSmust be restarted and themainmenuat the top of the
program will be displayed. To hide themainmenu, clear the check box. SeeUsing the
MainMenu for more information.
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Automatically schedule tasks in Microsoft Outlook

When selected, all tasks listed inScheduler will be communicated throughMicrosoft
Outlook to the assigned user.

Note: Anemail address for the assigned user must be previously entered inUser
Security.

I want to opt out...

If you do not want to participate in theProduct Enhancement or Product Survey
programs, select the check boxes on theGeneral Preferences tab.

Setup Interviews Tab

ASetup Interview is awizard that walks you through the setup specifically for Insurance
andSavings plans. Here you can enable or disable setup interviews at the user level. If you
enable aSetup Interview, the next time you chooseSetup > Employees > and Insurance
Plans orSavings Plans and click theAdd button, SageHRMSasks you if youwant to
use the setup interview to help you create an insurance plan or savings plan.

On this tab, select if youwant to enable the interview for the InsurancePlanSetup and the
Savings PlanSetup.

Setting Up Code Tables

About Code Tables

SageHRMSuses codes tomanage and store information in files. These codes provide
abbreviated, standard references to specific information. SageHRMS stores these codes
and their associated descriptions in code tables.

A list of state and province abbreviations is an example of a code table. Instead of typing or
re-entering a state name (such as Mississippi) in a field, you can select the appropriate
code (MS) from a list of predefined codes contained in a code table. Instead of typing
BritishColumbia, you can select the codeBC. Code tables contain one column for the
code and a second column for the code description.

A drop-down list provides information for a field related to a code table. For instance, if a
page contains a field for the state, a drop-down list provides a list of state codes, such as
MO, IA, andFL, from which you can choose.
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Benefits of Using and Defining Code Tables

Code tables provide several advantages. Using code tables allows you to:

Customize information to meet your employer's needs. For example, you can define
unique divisions, departments and locations specific to your employer.

Save time.When you enter information for hundreds of employees, it is much easier and
more efficient to type or selectRFT for each employee rather than typeRegular Full
Time.

Ensure accuracy and consistency.Without a uniform coding scheme, a data entry clerk
might enter a department code in several different ways (ENGDEPT,ENGRDEPT, ENG
or ENGR) for several different employees. Even though the clerk describes the same
department, SageHRMS interprets the entries as four different pieces of information for
four different departments. If the entries are inconsistent,SageHRMSwill not be able to
calculate department totals accurately.

Building Code Tables

Most code tables inSageHRMSare two-column tables containing codes in the left column
and brief descriptions in the right column. However, some tables aremore complex
(benefit plans, for instance) and containmore information than can fit in two columns. The
instructions for copying, adding, editing, and deleting codes are identical, whether youwork
with two-columnormulti-column tables. Most code tables have recommendeddefault
values. You can add, edit, or delete values to suit your employer’s needs.

All of the predefined code tables inSageHRMSare enterprise code tables. You can adjust
these code tables to contain the codes most frequently used by the employers in your
program. These codes then become the standard for your program.

When you initially set up a code table, the codes are blank. As long as theCodes area is
blank, an individual employer uses the codes from the enterprise code table. As soon as
you add a new code, the program recognizes you are creating a code table that no longer
references the enterprise code table. To add a code for a specific employer from the list of
enterprise codes, copy the enterprise code table to the employer code table and then add
the unique code to the employer’s code table.

l For example, if two of three employers in your program use the samecodes, edit the
enterprise code tables to accommodate the two employers.When you then set up
codes for the two employers who share common codes, they automatically use the
enterprise codes unless you create new codes in their code tables.
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l For the third employer who uses a slightly different set of codes, you can copy the
enterprise code table and thenmakewhatever minor changes are necessary to
meet the third employer’s coding requirements. Therefore, you save timeby not
having to create awhole new set of codes from scratch, yet you are still able to
customize the code table to the third employer’s specifications.

Setting Up Code Tables

SageHRMSallows you to quickly and easily add, edit, copy, and delete codes so you can
meet each employer's specific coding requirements. For instance, youmight want to
change a previously defined code to reflect a change in your organization.

Note: After you save a code, the following fields are disabled:

l Benefit Rate Tables

l Benefit Savings Plans

l AttendancePlans

l AbsenceReasonCodes

l FMLAEvent ReasonCodes

Working with Sage HRMS Code Tables

SageHRMSallows you to quickly and easily add, edit, copy, and delete codes so you can
meet each employer's specific coding requirements. For instance, youmight want to
change a previously defined code to reflect a change in your organization. The following
sections describe how towork with SageHRMS code tables.

ToCopy Code Tables

1. Select Setup > Employees, Time Off, Payroll, or Training > Click the link for
the type of codes you want to work with. The code table you selected opens.

2. Select the employer withwhom youwant towork.

3. Click Copy. Only those employers with codes defined in the current table appear in
the selection list. The employer withwhom youareworking does not appear in the
list because you cannot copy codes from anemployer to itself.

4. Highlight the enterprise or employer whose codes youwant to copy and clickOK.
For most code tables, theSelect Codes toCopy page opens. TheAvailable list
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shows all the defined codes for that code table. TheSelected list shows those
codes you select.

Note:When copying somecodes you are first shownadialog box informing you of the
related codes whichwill be updated to correspondwith those you are copying (see Job
Codes below). Click Yes to continue or click No to return to the code table page.

5. From theAvailable list box, double-click the codes youwant to copy. The selected
codes appears in the right list box. If youwant to remove a code from the
Selectedlist, highlight it and click Remove.

6. ClickOK. The program checks to see if the codes to be copied are the sameas
any which already exist for the employer receiving them. If there are any duplicates,
SageHRMSasks whether youwant the old code to be overwrittenwith the new.
SelectYes orNo.

7. Thenew codes are copied to the employer withwhich you areworking. To adapt
the code table to this employer’s needs, you can add additional codes to the list.

8. Click the Close button after you finishmaking your changes.

To AddCodes

1. Select Setup > Employees, Time Off, Payroll, or Training > Click the link for
the type of codes you want to work with. The code table you selected opens.

2. Select the employer withwhom youwant towork.

3. Click Add. The codes detail page opens.

4. Enter at least a code and description. Somecode tables ask for additional
information to be supplied for the added code. Other setup options are:

l Somecode tables contain a blank code described as None Specified. This allows
you to leave a field blank when you are entering information. To provide this option
for your own code tables, include a blank code alongwith the descriptionNone
Specified.

l Code tables for Jobs, Organizations, andReasons provide the ability tomake the
code active or inactive. When the code is active, it displays in the code selection
list when the user needs to select a particular code on a detail page. However,
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when the code is inactive (and theShow InactiveCodes setting on theEnterprise
Setup page is set toNo), the code does not display in the code selection list.

5. ClickOK. SageHRMS checks for duplicate codes and saves the changes if no
duplicate exists. If a duplicate is found, the program prompts you to enter a different
code.

To Edit Codes

1. SelectSetup > Employees, Time Off, Payroll, or Training > Click the link for
the type of codes you want to work with. The code table you selected opens.

2. Select the employer withwhom youwant towork.

3. Highlight the code youwant to edit and clickMore…. The detail page for the code
you selected opens.

Codes that have been set up in the following code tables cannot be changed. If you
need to change a code name, create a new code and delete the old one.

l Benefit Rate Tables

l Benefit Savings Plans

l AttendancePlans

l AbsenceReasonCodes

l FMLAEvent ReasonCodes

4. Edit the information and clickOK.

ToDelete Codes

1. SelectSetup > Employees, Time Off, Payroll, or Training then click the link for
the type of codes youwant tomodify. The code table you selected opens.

2. Select the employer withwhom youwant towork.

3. Highlight the code youwant to delete and click Delete. SageHRMSprompts you to
confirm the deletion. Also, deleting a code could affect history files and reports that
contain the code.

4. Click Yes to delete the record, or click No to cancel the deletion.

Getting Started Guide - 60



AddCodes From Details

5. Click theClose buttonwhen you finish.

AddCodes From Details

You can also directly add codes to a code tablewhen you areworkingwith details pages.
For every field that references a code table, SageHRMSprovides a drop-down list of
codes. For example, on theCurrent Job page, the Job Code field accesses the Job
Codes table.

SageHRMSprovides an option that enables you to add a new codewhile you are entering
information on the page.Whenworkingwith SageHRMS, you can add codes from pages
for all SageHRMS code tables except for theBenefit InsurancePlans, Benefit Savings
Plans, andBenefit Rate Tables. Youmust access these code tables inRules towork with
them.

To Add a Code From a Detail

Formore information about using drop-down lists, seeAbout Detail Pages.

1. Open the drop-down list for the field that references the code table youwant to
update.

2. Scroll to the bottom of the list and selectAdd New Code. A page opens so you can
add a new code.

3. Enter the information for the new code and clickOK. SageHRMSadds the code to
the list and selects the new code for the field.

Setting Up Security

Set Up Page Security

When setting up security for your system, you can define the access rights for specific
pages. Different users might have different kinds of security access to specific pages.
When you find an employee from apage, the only employees whoappear are those you
have permission to view.

For example, there are two security rules defined for a user named JoanMartin:

l Martin can view theCurrent Pay pages for employees in employer ABC and
employer DEF.

l Martin can view theWellness pages for employees only in employer ABC.
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When JoanMartin is working on theCurrent Pay page andwants to find an employee, she
can see all employees inABC andDEF. However, if she is working on theWellness page
andwants to find an employee, she is only able to see the employees inABC. She cannot
view or work on theWellness page of any employee in employer DEF because the system
denies her access to that information.

Set Up Security

SageHRMShas an extensive, flexible, and easy-to-use security system to protect your
data. You have complete precision in restricting access because the security system
breaks down functions within SageHRMSby employer, product, activity, task, step, and
groups of employees.

If you are the system administrator or the sole user of your system, you can set upSage
HRMS to have access to all security options. Usually an organization’s system
administrator sets up and changes security privileges for all SageHRMS system users.
For instance, as the system administrator, you can allow auser access to all employee
information except current pay data. Or, you can give a user the ability to enter only
demographic information for new employees.

As a normal user, you are assigned a user ID and passwordwhich establish your ability to
view, change, and process data. In this capacity, you are limited to changing your own
password.

Security Concepts

Each person accessingSageHRMShas a user ID, and each user ID is associatedwith a
password. You probably want to establish the same level of security access for a group of
users (not just one user), and theSage security system lets you create security groups
and establish different access rights for each group.

Group Security

A security group is a collection of one or more users with the sameaccess rights. Each
security group has a name (assignedwhen you create the group), and each user (other
than the system administrator) is amember of a group. As the system administrator, you
assign access rights to the group and not to an individual user. The group a user belongs
to determines the access rights of an individual user. As the system administrator, you
automatically have access to all functions.
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Note: The sole purpose of the security system is to restrict access to various areas
within SageHRMS. The system does not keep track of failed attempts to access system
features or report on the functions accessed by users.

User Security

Each security group contains one or more users assigned to that group. Each user must
have a user name, ID, and password to have access to the security group. There are two
ways a user can log on to the security group:

l WithSageHRMSuser name, ID, and password. To assign a user to a security
group, youwill need an ID, name, and password of the user.

l WithWindows logon and password. To assign a user to a security group, youwill
need to add a user's Windows logon credentials to the security group.

Before you Start

Prior to setting up access rights for your users, youmust set up several components in
your SageHRMS system.

1. Set up the enterprise.

2. Addand set up your employers.

Establish Access Rights

Establish access rights if youwant to restrict any portion of theSageHRMS system to one
or more users. However, it might not be necessary for you to set up security for your Sage
HRMS system. Consider the following two situations, neither of which require any security
setup.

l Youare the system administrator and you are the only one usingSageHRMS. You
do not need to set up security.When you sign on usingMASTER as the user ID, you
automatically have access to the entire system.

l Youwant all users to have unrestricted access to the system. Rather than setting up
any security, have each user log on usingMASTER as the user ID. Each user can
access the entire system.

Note: If you receive updates toSageHRMS that include new features, theMASTER user
ID is automatically updated and always has access to all features. For any additional
security groups you created previously, youmust update the security group information to
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provide access to the new features. This provides a safeguard so you can always decide
who can access the new features.

This next situation requires security setup. You are the system administrator and install the
following products on your system: TimeOff, SageHRMS,Multi-SiteConsolidation, and
SageHRMSTrain. Youwant to set up two users for the employer DunedinEnterprises.

The first user can only enter new employees into the system. The second user has access
to the entire system but cannot view or update certain fields. Youmust:

l Set UpaSecurity Group for User #1

l Set UpaSecurity Group for User #2

l Set UpUsers

If youmust further restrict your users and disallow access rights to specific employee
records, refer to Product GroupFilters.

Set Group Security

A security group is a collection of one or more users with the sameaccess rights. Each
security group has a name (assignedwhen you create the group), and each user (other
than the system administrator) is amember of a group. As the system administrator, you
assign access rights to the group and not to an individual user. The group a user belongs to
determines the access rights of an individual user. As the system administrator, you
automatically have access to all functions.

Note: The sole purpose of the security system is to restrict access to various areas within
SageHRMS. The system does not keep track of failed attempts to access system
features or report on the functions accessed by users.

Security Levels

When you (as the system administrator) set up security for a group, you can establish
access rights at the following levels:

l Employer

l Product

l Activity

l Task

l Step

l Field
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Theemployers include all the employers you set up in your enterprise.

You assign access rights to products depending on the products you have installed and
set up on your SageHRMS system. TheSystem is treated as a separate product to help
organize tasks.

Note: Youmust first selectN/A for the employer before you can selectSystem as a
product.

The activities you can assign access rights to include: Action, Analysis, Detail, Process,
Report, andRule. There is a different set of tasks for each activity and a different set of
steps for each task.

You can also set view and update rights for groups of specific fields in an employee’s
record, such as address and phone, salary, or EEO information.

Setting theAdHoc ReportingSecurity Level enables you to establish an access level for
Crystal andAbraSecureQuery. This access level determines which fields in theSage
HRMS system databases are able to be accessed by the security group’s users
whenever they useCrystal or AbraSecureQuery.

Add, Edit, or Delete a Group

To Add aGroup

1. SelectSetup > System > Security > Group Security.

2. Toadd a group, click Add. In theNew Group Name field enter the nameof the
group you are adding (up to 20 letters and numbers). ClickOK.

3. Click Yes to verify you are adding the group. The program builds the access rights
structure for this group. TheSecurity Group page opens.

4. Initially a new group has no access rights. Accordingly, the page has no entries in
any of the columns. TheModify button at the bottom of theEmployer column is
enabled, indicating you canmodify access rights at the employer level. All other
Modify buttons are disabled.

5. Click Modify. TheEmployer Selection dialog box opens. TheAllow Access
column for each employer is initially set toNo.

l TheEmployer list also contains theN/A option. Change the access toYes forN/A
in order to access System in theProduct columnon theSecurity Group page.
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6. Double-click the employer to change the access toYes.

Caution! If you allow a security group to access GroupSecurity under System
Rules, users in that group can change their own security access rights. They can
let their security group (and any other security group) access all features, which is
the sameas no security at all. We recommend limiting the access rights of all
security groups to only one security feature: ChangePassword. TheMASTER
user ID has access to all SageHRMS system features.

7. ClickOK. The system rebuilds the information on theSecurity Group page.

8. ClickModify in theProduct column to open theProduct Selection dialog box. The
Allow Access column for each product is initially set toYes.

If you haveU.S. Payroll andCanadianPayroll installed andwant to restrict access to
either U.S. Payroll or CanadianPayroll, youmust set the security in two steps. Let's say
youwant to restrict access so that users will only be able to access CanadianPayroll. In
theProduct Selection dialog box, set theAllow Access toYes forCanadian Payroll.
Then set theAllow Access toNo forPayroll (which is U.S. Payroll). It is imperative that
you set the access correctly for bothU.S. Payroll andCanadianPayroll.

9. Double-click the products to change the access toNo.

10. ClickOK to return to theSecurity Group page.

11. Select the product for which you are setting security. All activities, tasks, and steps
appear in the related columns.

12. ClickModify in theActivity column to open theActivity Selection dialog box. The
Allow Access column for each activity is initially set toYes.

13. Double-click the activity to change the access toNo.

14. ClickOK to return to theSecurity Group page.

15. Select the activity for which you are setting security. The tasks and steps appear in
the related columns.

16. ClickModify in theTask column to open theTask Selection dialog box. TheAllow
Access column for each task is initially set toYes.

17. Double-click the task to change the access toNo.

18. ClickOK to return to theSecurity Group page.
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If a user has a task assigned on their Scheduler, the security system does not allow you
to restrict that user’s access to that task. Therefore, because the user is amember of a
security group, the security system does not allow you to restrict that group’s access to
that task.

19. Select the task for which you are setting security.

20. ClickModify in theStep column to open theStepSelection dialog box. TheAllow
Access column for each step is initially set toYes.

21. Double-click the step to change the access to No. If you selectedDetail in the
Activity column, double-click the steps to change access to View,Update, or
None.

22. Click OK to return to theSecurity Group page.

23. Repeat steps 4 through 22 to set access rights for another employer, product,
activity, task, or step.

24. ClickOK to return to theSecurity Groups dialog box.

To Edit a Group

1. SelectSetup > System > Security > Group Security.

2. Select the groupwithwhom youwant towork.

3. Click More…. TheSecurity Group page opens.

4. Edit information as necessary.

5. ClickOK.

ToDelete a Group

1. SelectSetup > System > Security > Group Security.

2. Highlight the group youwant to delete and click Delete.

3. Confirm the deletion.

4. If there are no users in the group, the system deletes the group.
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5. If there are users in the group, the system alerts you and asks you to confirm the
deletion again. If you selectYes, the group and any users within the group are
deleted.

6. If a user within the group has tasks scheduled on their Organizer, the system alerts
you and does not allow you to delete the group. ClickOK to display the user’s task
schedule.

Before deleting the group, remove the scheduled tasks from the user’s Organizer. Delete
the user or assign the user to another security group. Repeat the above procedure to
delete the group.

Review the list of tasks. To print the tasks for easy reference, click Print. Click theClose
button to return to the GroupSecurity dialog box.

Set up User Security

Each security group contains one or more users assigned to that group. Each user must
have a user name, ID, and password to have access to the security group. There are two
ways a user can log on to the security group:

l With their SageHRMSuser name, ID, and password. To assign a user to a security
group, youwill need the user's ID, name, and password.

l With theirWindows logon and password. To assign a user to a security group, you
will need to add the user's Windows logon credentials to the security group.

To Add a User with a Sage logon

1. SelectSetup > System > Security > User Security.

2. Click Add. TheUser Security dialog box opens.

3. In theGroup field, select the security group towhich you are adding this user.

4. In theAuthentication field, selectAbra.

5. Enter up to ten characters for theUser ID. You can enter the user’s initials, the first
name, and the first letter of the last nameor any other suitable abbreviation. The
system converts all characters to upper-case.

6. Enter up to 25 numbers or characters for aUser Name. It can be any combination of
uppercase and lowercase letters and numbers. The user name should contain the
user's full first and last name. It is used in the scheduler for task assignments.
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7. Enter up to 10 characters for the user’s Password. For security reasons, youwill
not see the password that you enter. Only asterisks appear in the field. The system
automatically converts all characters to upper-case.

8. Enter up to 64 characters for the email address assigned to the user.

9. Enter up to 25 characters for the user's Position, such as a job title.

10. If you are also usingSageHRMS Link, you can choose toAllow Access to
Abra Link. If you do not want this user to have access toSageHRMS Link, click
No. Otherwise, click Yes.

11. Leave the Inactivate User ID selection toNo to add an active user.

12. ClickOK. ThePasswordVerification dialog box opens.

13. Enter the user's password again for verification and clickOK. The system records
the password and returns to theUser Security page.

14. Repeat steps 2 through 10 to set up additional users.When you finish, close the
Security Groups dialog box.

Note: TheMASTER user will always use theSage authentication. If theMASTER user
tries to use theWindows logonwhen logging on to the application, they will receive an
invalid user name/passwordmessage.

To Add a User with their Windows logon authentication

1. SelectSetup > System > Security > User Security.

2. Click Add. TheUser Security dialog box opens.

3. In theGroup field, select the security group towhich you are adding this user.

4. In theAuthentication field, selectWindows.

5. Click theSearch Windows User button to open theSelect a userwindow.

6. Scroll or use search criteria to find the user and clickOK to return to the User
Security window. TheUser ID andUser Name fields show the user's Windows
authentication. Note that the domain is included as necessary. ThePassword field is
blank as the user will provide this when they log on.

7. Enter up to 64 characters for the email address assigned to the user.
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8. If you are also usingSageHRMS Link, you can choose toAllow Access to
Abra Link. If you do not want this user to have access toSageHRMS Link, click
No. Otherwise, click Yes.

9. ClickOK. The user you added displays in theUser Security list. TheAuthentication
column indicates the type of logon set for the user.

10. Repeat steps 2 through 9 to set up additional users.When you finish, close the
Security Groups dialog box.

Note: Youmust repeat this process inSample data if the user is to be able to access
Sample data usingWindows Authentication. Additionally, if you are also usingSage
EmployeeSelf Service, youmust set upWindows Authentication separately from within
SageESS.

To Edit a User

1. SelectSetup > System > Security > User Security.

2. Select the user withwhom youwant towork.

3. ClickMore…. TheUser Security dialog box opens.

4. Edit information as necessary.

Note: If you edit a user and change the security group to restrict the user’s access,
make sure you reassign the tasks this user is no longer able to perform due to
restricted access. For information about assigning tasks, seeUse theScheduler.

5. ClickOK.

To Inactivate a User

1. SelectSetup > System > Security > User Security.

2. Select the user youwant to inactivate.

3. Next to InactivateUser ID, click Yes.

4. Click theClose button to return to theUser Security window.

Users whoattempt to log on toSageHRMSwith an inactivated user ID are presentedwith
an "Invalid username/password."message and cannot log on.
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To Delete a User

1. SelectSetup > System > Security > User Security.

2. Select the user youwant to delete.

3. Click Delete. If the user is not scheduled to perform any tasks, confirm the deletion.
If the user has tasks scheduled on their Organizer, theSageHRMS system alerts
you and does not allow you to delete the user. ClickOK to display the user’s task
schedule.

4. Review the list of tasks. To print the tasks for easy reference, click Print. Click the
Close button to return to theUser Security dialog box.

Before deleting the user, remove the scheduled tasks from the user’s Organizer. After
deleting the tasks, repeat the above procedure to delete the user.

Set Field Level Security

Field Level Security lets you limit access to certain categories of data for a specific
employer. It is available for SAPCrystal Reports, AbraSecureQuery and someSage
HRMSdetail pages. Field Level Security is set at the group level, and all the users you
assign to the groupmust adhere to the type of security you select for each category.

When you initially add a security group, the group does not have access to view or update
fields containing information in the following categories: Address/Phone, Salary, and
EEO.You can provide access to view or update these fields through field level security.

Note: Field security is not available for standard reports. If you need to prevent certain
employees from viewing specific fields on standard reports, consider removing the entire
report from themenus towhich the employees have access (use group security to
remove reports frommenus).

Field Level Access

Fields in theAddress/Phone category pertain to home, not business information. This
information is located on theDemographics page and includes the telephone number,
street address, city, state and zip code, county, and country.

Fields in theSalary category are found on thePayroll Status page inSageHRMSPayroll
and theCurrent Pay Status page inSageHRMS. Information includes the

l unit pay rate

l pay period salary
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l hours/units worked per pay period

l pay frequency

l annual pay

l shift premium

l last pay change amount or percent bonus amount (if applicable)

l salary grade

l frequency of the employee’s contribution to savings plans

TheEEO category controls access toEEO information and includes marital status, ethnic
origin, gender and disability.

Note: Not all these fields are contained in theSageHRMS system databases. Therefore,
for some fields, you can only set field level security if you selected products other than the
SageHRMS system.

Setting Field Level Security

Set Field Level Security

1. SelectSetup > System > Security > Group Security.

2. Select the groupwithwhom youwant towork.

3. ClickMore…. TheSecurity Group page opens.

4. Click theField Level Security tab.

5. Select an employer from theEmployer Selection list.

6. For each applicable category, select the appropriate access level by selecting one
of the options listed in the following table. Access rights to fields containing
Address/Phone, Salary, or EEO information initially default toNot View.
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Option Description

Not
View

Restricts users from viewing and updating the data.When
users access areas of the system containing these fields, the
wordHidden is displayed.
Note: If users cannot view a fieldwhich appears on a report,
they are restricted from generating that report.

View Enables users to view the data but restricts them from
updating it.

Update Enables users to view and update the data.

7. Click Apply to save your changes. You can then select another employer and set
field security for that employer.

8. When you are finished setting field security for employers, you canmove to another
tab on theSecurity Group page or clickOK to close the page.

Set Product Group Filters

In addition to restricting access to specific fields with the field level security function, you
can select specific employees youwant the security group users to access. For example,
if youwant users of a security group to access only employees whose original hire date is
prior to June 1, 2002, theSageHRMS system lets you set a product group filter allowing
access to only employees fitting that criteria.

Setting up a Product Group Filter

To Set a Product Group Filter

To tell the system which database records youwant a security group’s users to be able to
access, build an expression on theProduct Group Filters tab of theSecurity Group
page.

1. SelectSetup > System > Security > Group Security.

2. Select the group youwant towork with.

3. ClickMore…. TheSecurity Group page opens.

4. Click theProduct Group Filters tab.
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5. Select the product you are using for this group filter.

Note: If SageHRMSPayroll is includedwith your system, any product group filters
you set for HR automatically apply toPayroll. Therefore, if you select Payroll as
your Product Selection, the Fields listed are disabled and cannot be specifically
selected for Payroll.

6. Build the expression. An expression consists of a field, relationship, and value. The
following sections step you through building an expression.

Field

TheFields list contains every field in themaster file corresponding to your product. For
example, for SageHRMS, the list includes every field in theEmployeePersonnel file.

Use the scroll bar in theFields list to locate the field and double-click to select it. The field
appears in theExpression box.

Relationship

TheOperators list contains themathematical operators signifying the relationship in our
expression. Operators specify a relationship between the field and the value. Refer to the
followingOperators table to see the valid operators and their descriptions.

Use the scroll bar to locate the operator and double-click to select it. The operator is added
to the expression in theExpression box.

Operators

Operators

Operator Description

= Equal to

!= Not equal to

> Greater than

>= Greater than or equal to

< Less than

<= Less than or equal to

AND And - for compound expressions
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Operator Description

OR Or - for compound expressions

+ Add - usedwhen computing a value

- Subtract - usedwhen computing a value

* Multiply - usedwhen computing a value

/ Divide - usedwhen computing a value

Value

Enter the expression’s value directly into the expression. For example, youwant users of a
security group to access only employees whose original hire date is prior to June 1, 2002.
Place your cursor to the right of the operator. Enter the date in numeric form andenclose it
in braces. Your expression reads:

P_ORIGHIRE < {06/01/2002}

Theexpression is complete.

Note: Themaximum length of an expression is 200 characters.

Verify the Expression

Click Verify tomake sure your expression is built in a format the system can interpret. The
system indicates if the expression is valid. If it is not, determine your error, place your
cursor in theExpression box, and then correct the error. Use theBackspace andDelete
keys to clear the expression as necessary.

When your expression is correct, click Apply to save your changes and remain on the
Security Group page, or clickOK to save your changes and close theSecurity Group
page.

Note: You can also build a compound expression. For example, if youwant to limit access
to employees whose original hire date is betweenApril 1, 2002 and June 1, 2002, your
expression reads:

P_ORIGHIRE > {03/31/2002} AND P_ORIGHIRE < {06/02/2002}

Tip: The format of expressions is consistent with theXbase programming language
standards, except theAND andOR operators do not need to be enclosedwith periods. If
you are familiar with formatting expressions, youmight find it easier and faster to enter the
complete expression simply by clicking in the expression box and typing the entire
expression.
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Editing or Deleting a Product Group Filter

To Edit or Delete a Product Group Filter

1. SelectSetup > System > Security > Group Security.

2. Select the groupwithwhom youwant towork.

3. ClickMore…. TheSecurity Group page opens.

4. Click theProduct Group Filters tab.

5. Select the product for which youwant to edit or delete the group filter.

6. Place your cursor in theExpression box and edit the expression as needed. If you
want to delete the filter altogether, use theBackspace andDelete keys to clear the
entire expression.

7. Click Apply to save your changes and remain on theSecurity Group page, or click
OK to save your changes and close theSecurity Group page.

Set Ad Hoc Reporting Security

SAPCrystal Reports andAbraSecureQuery enable you to design and generate your own
queries and reports using system database files. Any user who has access toCrystal or
AbraSecureQuery can view any fieldwithout restrictions. AdHoc ReportingSecurity lets
you restrict the database files and fields available to a security group usingCrystal or Abra
SecureQuery.

When you set up security for a group, you can assign anAdHoc ReportingSecurity Level
to each security group. To further restrict access to the user, AdHoc ReportingSecurity
lets you assign an access level to each field included in your SageHRMSdatabases.

Note: Theaccess levels you assign here affect access only inCrystal andAbraSecure
Query and do not impact the rest of the system.

How Access Levels Work

Before changing access levels, you need to understand how access levels work. This
section illustrates why youwould change access levels for your database fields.

Each field in each database file contained in your SageHRMS system is listed on this
page. The fields are grouped alphabetically by database file. Each line item displays the
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database file name, the field description, and the field’s access level. There are nine
access levels (one through nine). Initially, all fields are set to the sameaccess level, one.

Allow All Users Access to All Fields

Working in conjunctionwith AdHoc ReportingSecurity is theAdHoc ReportingSecurity
Level feature on theSecurity Group page.

Initially, when you set up security for a group, theAdHoc ReportingSecurity Level is set
to one, just as each field in AdHoc ReportingSecurity is set to one. This means the
group’s users can access all the fields set to one.

If youwant all users to have access to all fields when they generate reports usingCrystal
or AbraSecureQuery, maintain one as your AdHoc ReportingSecurity Level and you do
not have to change anything inAdHoc ReportingSecurity.

Note: TheMASTER user ID has anAdHoc ReportingSecurity Level of nine and can
access all fields.

Restrict User Access to Fields

To restrict a user’s access to specific fields in a database, change the field’s access level
as well as theAdHoc ReportingSecurity Level for the user’s security group. The
combination of a group’s AdHoc ReportingSecurity Level and a field’s access level set in
AdHoc ReportingSecurity determines if the field is accessible by a user. Consider the
following example:

Wehave two security groups and one user in each group. The first group, DataEntry, has
a user calledDE. The second group, Pay Manager, has a user calledPM. Except for one
restriction, wewant these users to have the samecapabilities generating custom reports
inCrystal andAbraSecureQuery. However, we do not want DE to have the capabilities
to generate a custom report containing theEarnings/Deductions Code field.

In AdHoc ReportingSecurity, we change the access level for theEarnings/Deductions
code to five.We leave theAdHoc ReportingSecurity Level at one for theDataEntry
group, and change it to five for thePay Manager group.

Now, whenDE (amember of theDataEntry group) accesses Crystal or AbraSecure
Query, DE cannot create a report containing theEarnings/Deductions Code field. DE’s
security group is set at access level one, which prohibits DE from accessing any Sage
HRMS fields with an access level higher than one.
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In order to access theEarnings/Deductions Code field, a user’s groupmust have anAd
Hoc ReportingADASecurity Level of at least five. Consequently, user PM canaccess
this field. In addition, if we set theAdHoc ReportingSecurity access level to six for the
Earnings/Deductions Code field, evenPM is unable to use that field inCrystal or Abra
SecureQuery, becausePM's access level is only five.

To Set Access Levels

TheAdHoc ReportingSecurity page has themeans to quickly and easily change access
levels for fields in your databases. Before setting access levels, determine towhich fields
youwant to restrict access.

You can set the access level of all fields in all database files, all fields within one database
file or one field at a time. The database files and the fields within the files are listed
alphabetically. Use the product’s DataDictionary to help you locate a specific fieldwithin a
database file.

1. Select Setup > System > Security > Ad Hoc Reporting Security.

2. Set the access levels as necessary.

3. To set all fields in all database files, enter a number from one to nine in theAll
Fields number box at the top of the page. You can also use the arrows to set the
level. All fields change to the access level you set.

4. To set all fields within one database file, locate the database file and click any line
item within the file. Enter a number from one to nine in the Fields for Selected File
number box at the top of the panel. You can also use the arrows to set the level. All
fields within the selected database file change to your selected access level.

5. To set one field at a time, use the scroll bar to locate the field. To set the access
level, click the line item to select it and enter a number from one to nine.

Tip: Set the access level for all fields in all database files first. If youwant a different
access level for specific files, set them next. Remember, setting an access level for all
fields overrides any previously established field settings.

Ad Hoc Reporting Security Level

Setting a group’s access level for SAPCrystal Reports andAbraSecureQuery works in
conjunctionwith settingAdHoc ReportingSecurity.When you set security for SAPCrystal
Reports andAbraSecureQuery, you can define access rights at the field level, and each
field in your SageHRMS system is assigned its own level of security.
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When you set up security for a group, selectSetup > System > Security > Group
Security to establish an access level for SAPCrystal Reports andAbraSecureQuery.
This access level determines which fields in theSageHRMS system databases are able
to be accessed by the security group’s users whenever they useCrystal or AbraSecure
Query.

For example, if you set theAdHoc ReportingSecurity Level to one, users can only access
database fields with an access level of one. If you set theAdHoc ReportingSecurity Level
to two, users can access database fields whose access levels are one or two. Following
this logic, if you set theAdHoc ReportingSecurity Level to nine, users can access all
database fields and have access to levels one through nine.

To Set a Group's Ad Hoc Reporting Security Level

1. Select Setup > System > Security > Group Security.

2. Double-click the group youwant towork with to open theSecurity Groups page.

3. Set security forEmployer,Product,Activity, Task, andStep.

4. If necessary, set a product group filter and field level security.

5. Change theAd Hoc Reporting Security Level by entering a number from one to
nine or use the arrows to change the number.

6. ClickOK to save your changes and return to theSecurity Groups dialog box.

7. Click theClose button to close theSecurity Groups dialog box.
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